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ABOUT THIS DOCUMENT 

This document is intended for any user of DT Max, be it a beginner or advanced user. In this guide, we will cover the 

multitude of features offered by DT Max and present in its three screens. 

On DT Max’s first screen, the Client List, we will view how to effectively personalize and sort your client list in order 

to access specific clients with ease and speed. 

On DT Max’s second screen, the Data Entry, we will discuss the concept of using keywords to enter your clients’ tax 
information. We will look into the various tools provided by DT Max to enter as well as search for these keywords. 

On DT Max’s third screen, the Tax Return, we will discuss the different forms that are generated as well as the many 

review tools available such as field tags and the QuickSource feature. 

Finally, we will cover the proper setup and configuration of the Preferences menu which will include the Identification, 

User’s defaults, and Forms Manager sections amongst many others. 
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DT MAX BASICS 

In the following paragraphs, we will see the basic features of DT Max. 

SPLASH SCREEN 

When you open DT Max, the first screen that will be presented to you is the Splash Screen. 

You must first select a folder that will house the files of your Client Database. You may select your Database 

location by clicking the browse icon. 
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You may now enter a Username or Accountant ID. A user Password may also be added. We will discuss user 

privileges and passwords in the Security System chapter. 

Select the Tax year you wish to access by choosing the appropriate year from the scroll-down menu. Once in the 

program, you will still have the option to rapidly change taxation years without having to restart DT Max. 

Next, select the DT Max product you wish to load. In this case, we will select T2. 
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Recently accessed clients will also be listed on this screen. You may access them directly by double-clicking the 

desired client. DT Max will load the Client List screen with the selected client highlighted. 

The Splash Screen also provides many useful links such as the knowledge base, online video tutorials, and the 

DT Max support page. 
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Once you have enter all the relevant information, run DT Max by clicking on Start. 
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CLIENT LIST 

When you start DT Max, the first screen you will enter is the Client list. The Client list displays all the client files that 
are currently being processed as well as the client files that have been carried forward from one year to the next. 

Certain basic information of every client’s file is displayed directly in the Client list. For example, you can view the 
client’s number, name of the corporation, phone number, business number, year-end, Processing Status, etc… All 
this information is displayed directly in the Client list. 

Personalizing the Client List 

In order to personalize the Client list, go to the Preferences Menu, and select Client List Settings. 

You can also personalize the Client list by clicking on the Customize Client List icon. 
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A new window will appear, allowing you to select the information you want to add or remove from the Client list. 

By ticking a box next to any item in this window, DT Max will add that information as a column in your Client list. 
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Sorting the Client List 

Certain columns of the customer list can be sorted such as the client number, corporation name and year end. 

To sort your list by name, just click on the name column. The symbol "-" will become an arrow, indicating that the 

customer list was sorted by name. 

To sort your Client List in numerical order, click on the Client # tab. The symbol “-” will become an arrow, indicating 
to you that the Client list has been sorted by client number. 

Adding a new client to the Client List 

In order to add a new client to your Client list, simply click on the New Client icon. You can also add a new client 

by pressing F3 on your keyboard. 

A window will appear to configure the new company. You can change the client number that is automatically 

assigned to the new company. 
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DT Max allows you the option of using a Data Entry tool called the Smart Start. More details on this tool will be 

provided in the Data Entry portion of this document. 

Finding clients within the Client list 

To find clients that are already in your Client list, go to the Find Client box, located at the top right of your screen. 

In the Search by drop-down menu, choose the type of search you want to perform. You can search your clients by 

Name, Client number, or Phone number. 

Increasing/Decreasing Font in the Client List 

To increase the font within your Client list, click on the Zoom in icon. You can also hold CTRL and press “+” on 

your keyboard. 

To decrease the font within your Client list, click on the Zoom out icon. You can also hold CTRL and press “-”.on 

your keyboard. 
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DATA ENTRY 

Once you have created the new corporation, you will enter the Data Entry screen. The Data Entry screen is where 

all tax information is entered for your client’s tax return. You enter this information through Keywords. Each 

keyword represents a question DT Max is asking you on your client’s file. In order to complete your client’s tax 
return, you must “answer” the questions the program is asking you through the keywords. 

Adding keywords in the Data Entry 

There are 3 ways of adding keywords within your client’s Data Entry. 

SmartStart Client Profile 

To access the SmartStart Client Profile, you can click on the SmartStart client profile icon, or press ALT-F3. 

A new window will appear, allowing you to pick sections that are pertinent to your client’s tax return. 

All keywords that are located within the Data Entry screen are grouped into the SmartStart sections. Simply select 

the pertinent sections to your client’s tax return, and DT Max will add the appropriate keywords for you. 
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When selecting a section on the left, DT Max will show you the keywords that belong within that section on the 

right. 

After making your selections, you can save those selections as a default for any upcoming new corporations. 

Click on Continue, and DT Max will add the sections you have selected into your client’s Data Entry. 

Expand the sections by simply clicking on the “+” symbol to the left of the section header. Complete the appropriate 

keyword accordingly. 
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Manual Entry of keywords 

To manually enter keywords into the Data Entry, simply click on the Add keyword icon, or press F11. 

A new window appears allowing you to enter a keyword directly. 

There are several types of keywords you can enter. You can enter the schedule number directly as a keyword. For 

example, if you enter S007, DT Max will take you to keyword IncomeSource, and select the type of income from 

the drop-down menu. 

You can enter form numbers directly as a keyword. For example, you can enter CO-1029.8.36 as your keyword. 
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In the new window, choose the appropriate keyword from the list then click OK. DT Max will add the keyword in the 

data entry screen. 

You can enter broad descriptions as keywords. For example, you can enter GIFI as your keyword. 
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Keyword Help Index 

To access the Keyword Help Index, click on the Keyword Help Index icon, or press F8. 

A new window appears, allowing you to search your keyword through several methods. 

When you click on the Topic tab, DT Max presents you with various topics or subjects that you can choose from in 
order to locate the keyword you need. Once you find the topic that is suitable, select it, and DT Max will present to 
you a list of keywords you can use. Double-click on the keyword you need, and DT Max will add it to the client’s 
Data Entry. 
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When you click on the Jacket tab, DT Max presents you with all the line numbers that are located on the tax return 

for both the Federal and Quebec returns. Click on a specific line number, and DT Max will present to you a list of 

keywords you can use to enter an amount on that specific line. Double-click on the keyword you need, and DT Max 

will add it to the client’s Data Entry. 

When you click on the Form tab, DT Max presents to you all the forms of the tax return that it calculates. Select a 

specific form from the list, and DT Max will present you with a list of keywords you can use to enter information on 

that specific form in the client’s tax return. Double-click on the keyword you need, and DT Max will add it to the 

client’s Data Entry. 
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Fields marked with an asterisk 

Fields marked with an asterisk require mandatory or important information. 

All fields marked with red asterisks (*) are mandatory fields. The field cannot be left blank because it will prevent 
the calculation of the tax return. 

DT Max will generate an error message marked with a red circle in the Error and warning messages window. 
(See section Errors and Warnings messages) 

Fields marked with blue asterisks (*) require important information for the production of the income tax return. 

If information is missing, a blue error message will appear in the Error and warning messages window. (See 
section Errors and Warnings messages) 

Error and Warning messages 

In order to view any errors or warnings you may have in your client’s file, click on the Error and warning 
messages icon. 

A new window appears showing you messages of required entries which are missing in the client’s file or errors 
made in the Data Entry. 
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Error messages that are indicated in red prevent you from calculating and viewing the client’s tax return. 

Errors messages in purple are errors from the GIFI (General Index of Financial Information). These error messages 

will prevent the barcodes from generating in the tax return. 

The error messages in blue will prevent the production of the tax return and the barcode return from generating in 
the tax return screen. 
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Error messages that are in yellow are warnings that do not prevent you from calculating your client’s tax return. 
However, these messages might prevent you from EFiling the client’s tax return. 

In order to correct an error message, simply double-click on the message itself, and DT Max will direct you to the 

keyword that you have to complete or correct. 

Keyword Groups 

Most keywords entered within DT Max are part of what is called a Keyword Group. The keyword group starts with 

a keyword that is in bold, which is called the Main keyword of the group. It is delineated by a bracket to the left of 

the keyword group. 

To the left of the Main keyword, you have the Expand icon. Click on this icon to expand or close a specific keyword 

group. 

Expanding a keyword group allows you to see the Secondary keywords within the group. A keyword group has 

been expanded when the bracket delineating the group is jagged. 

When completing a keyword group, you must always complete the Main keyword of the group before 

completing the Secondary keywords. If you do not follow this rule, DT Max will indicate an error message that 

will prevent you from recalculating (first element of the group cannot be blank). 



22 

Keyword explanation (functionality) 

When encountering a confusing keyword, there are several ways of finding out the functionality of the keyword. 

Hover your cursor over a specific keyword, and DT Max will give you a brief description underneath the cursor, that 

describes what the keyword does. 

If you are already on the keyword (highlighted in yellow), look at the bottom task bar of the program. DT Max will 

give you a brief description of the functionality of the keyword. 

A more detailed way of finding out the functionality of a specific keyword is to right-click on the keyword, and select 

Help for this keyword. You can also press CTRL-F8 on your keyword. 
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A new window will appear, giving a more detailed explanation on the functionality of the keyword and, if relevant, 

links to the corresponding government documentation. 

TAX RETURN SCREEN 

Once you have completed the Data Entry of your client and you have cleared all the error and warning messages, 

you are now ready to view the tax return. DT Max will produce the entire tax return based on the entries you have 

made in the Data Entry. Simply click on the Tax Return tab to view the tax return. You can also go to the Tools 

menu, and select Recalculate current client, or press ALT-F9. 

Page Index 

On the left-hand side of the screen you will see the menu Select a page. In this section you will see all the forms 

required to file the client’s tax return as well as the calculation sheets and in house forms used to generate the 

return. 
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By clicking on a form, DT Max will display the completed form on the right-hand side of the screen. 

The forms listed in the Page Index are colour coded. 

Forms that are shown in grey are in-house forms. These are not official government forms. These are forms 

created by DT Max to give you additional information on your client’s return. These include summaries and other 

calculations that are not found on the tax return. 

Forms that are shown in beige are the reproduction of the official Federal forms. These forms are completed by 

DT Max based on the entries in the client’s data entry. They include the tax return, schedules, and other relevant 

forms. 
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Forms that are shown in green are the reproduction of the official Provincial forms, including the Quebec tax 

return. These forms are completed by DT Max based on the entries in the client’s data entry. 

QuickTrack feature 

DT Max offers a sourcing feature called QuickTrack, which allows you to "source" an amount appearing on the tax 

return by clicking through to the applicable schedules and forms and ultimately the original keyword entry. 

In order to “source” a specific amount on a form to its origin, simply double-click on the amount or right-click it and 

select Go to source. DT Max will take you to the source form where the amount was calculated. 

In order to see the source keywords to use for a specific field that is currently blank, simply double-click on the 

empty field or right-click the field and select Source keywords. 

. 
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A new window will appear with a list of keywords you can use in order to enter an amount within this particular field. 

Choose the appropriate keyword and select Add to data. DT Max will take you back into the Data Entry to the 

specific keyword that you have selected. 

You can also perform field overrides directly on the specific fields using QuickTrack. Simply right-click on the field, 

and select Override this field. A new window will appear, allowing you to enter an amount within that field without 

using the Data Entry. 

Disclaimer: We strongly discourage the use of field overrides. They can cause calculation errors, and render your 

client’s tax return ineligible for EFile. Please contact our support department before using any field overrides. 

Printing the tax return 

Once you have verified the tax return, you are now ready to print. In order to print the entire return or perform what 

is called Production printing, click on the Production printing icon. 
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A new window appears, with several options to choose from. 

By default, you will be on the Print job setup tab. On the left-hand side, under Step 1, choose the clients you want 

to print. Your choices are current client or marked clients. 

Below, choose which versions of the tax return you want to print: the Production or the Plans (Plans will be 

discussed in a later chapter) 
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On the right, under Step 2, choose which copies to print. You can print all destinations from the Forms Manager or 

select the specific ones you want to print (Forms Manager will be discussed in a later chapter). 

You may also choose to print a selection of pages rather than doing a full production printing. To print selected 

pages only, click the Select pages to print icon. 

In the Forms printing window, select the appropriate printer and number of copies to print in the Printer section. 
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In the Select pages section, all relevant forms for your client will be listed. Select the page(s) you wish to print and 

click Print. 

Tip: You may choose to select the pages one at a time by holding down CRTL on your keyboard and clicking the 

corresponding pages from the list. 

PREFERENCES MENU 

The Preferences menu is the place where you can setup DT Max to perform automatic tasks for you. In the DT 

Max Basics section, we will see the items you should setup at the beginning of every year before starting any files. 

Identification 

The Identification section is the place where you will enter your identification information as a tax preparer. DT Max 

will automatically complete the relevant authorization forms for all your clients in the Client List. 

In order to set this up, go to the Preferences menu and select Identification. 
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In the first tab, Main name and address enter the identification information of your firm. 

In the second tab, Alternate Address, enter an alternate address you can use for certain tax returns. To activate 

this address in a particular tax return, use the keyword FIRM-ADDRESS, and select Alternative address in the 

client’s Data Entry. 
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In the third tab, Identification numbers, enter all of your pertinent identification numbers that identifies your tax 

preparation practice. At the bottom left of the window, enter the relevant ID numbers needed for the RC59. Click 

Save once you are done. 

User’s Defaults 

The User’s Defaults section is the place where you can choose defaults for all your clients. Through this section, 

you can have DT Max automatically complete certain areas of your clients’ tax returns. Moreover, you can setup 

technical defaults as well, such as your range of client numbers and a verification system. 

In order to access this section, go to the Preferences menu, and select User’s Defaults. 
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The first tab is the Client information tab. Within this tab, you can select the default province of residence, city, 

and language of correspondence for all new clients added to your Client List. 

In the Tax calculations tab, indicate how you want DT Max to handle the instalment payment calculation. 
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In the Tax Return tab, you can set up fields that DT Max will automatically complete in the client’s tax return. You 
can also set up your defaults for the authorization forms generated within your client’s tax return. You can set the 

limit of consent and the level of authorization you want for all your clients. 

In the Miscellaneous tab, you can setup other preferences such as the range of client numbers, verification 

requirements (discussed later on), company logo on the client letter, and enabling sorting. 

Once you have gone through all the tabs, click Save at the bottom of the window, and DT Max will apply this setup 

to all your clients. 
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Forms Manager 

The Forms Manager is the place where you determine what forms will print when you print your client’s tax return 

through Production Printing. 

To access the Forms Manager, go to the Preferences menu and select Forms Manager. 

You will now see a list of forms on the left-hand side of the window as well as columns. Each column represents a 

Destination. In other words, the forms that are printed under a particular column are “destined” for the place 

indicated in the column header, for example, the client copy. 
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There are 4 different options to choose from when editing the Forms Manager. The options are: Do not Print, 

Print if required (paper), Print if required (paper or EFile), and Print if data exists. 

Under the Federal CRA and Quebec RQ Destinations, choosing Print if required (paper) for a specific form 

means that the form will print IF it is required AND you are paper-filing the client’s tax return. 

Choosing Print if required (paper or EFile) for a specific form means that the form will print IF it is required 

regardless if you are EFiling or paper-filing your client’s tax return. 

Under every other Destination, choosing Print if required (paper) or Print if required (paper or EFile) will 

perform the same task whether you are EFiling or paper filing. 

If you choose Print if data exists for a specific form, DT Max will print the form not only if it is required to make a 

complete tax return, but also if it contains any information that may be useful in understanding or verifying the 

return. This applies to all Destinations. 

Tip: A quick way of editing the Forms Manager is to cancel the printing of all the forms within a Destination and 

then select the forms you wish to print. 
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In order to do this, click on the Destination header. Once clicked, the entire column will be highlighted in yellow. 

Right click in the highlighted area, and select Do not print. 

Now pick the forms you would like to print by right-clicking at the intersection of the form and the Destination, and 

choose amongst the 4 different options. 

Once you have completed the editing of the Forms Manager, click on Save. DT Max will now apply your setup to 

all your clients’ returns within the Client List. 
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It is strongly recommended that you print your Forms Manager setup after you have completed the editing. This 

allows you to have a backup copy of the setup you have performed. 

In order to print your Forms Manager setup, click on Print this list. 

If you make mistakes editing your Forms Manager, you can always return to DT Max’s default setup. 

In order to reset your Forms Manager, click on Reset. 

A new window appears. Select Reset to DT Max defaults. Then click OK. 
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DT MAX ADVANCED FEATURES 

Now that we have seen some basic features of DT Max, we will visit some more advanced features of the program. 

We will breakup these features amongst DT Max’s three screens and the Preferences menu. 

CLIENT LIST 

Filtering the Client List 

DT Max allows you to filter your Client List in order to find specific clients that meet certain criteria. For example, 

you can find your clients that have an EFile error in their file, clients for which you used a specific keyword in their 

Data Entries, etc… These filters are customizable to suit your needs. 

In order to set up filters in DT Max, within the Client List screen, go to the Tools menu and select Filter the Client 

List. 

A new window appears, allowing you to choose amongst available or spare filters. Choose one of the spare filters 

to customize and click Edit filter. 
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A new window appears, with several customization options to choose from. As a first step, you should always 

change the name of the filter to what you are trying to find. 

You can use one or several filters in combination when filtering your Client List. 

Accountant Code 

You can filter your Client List by the Accountant code, or User ID, that is assigned to a specific client. Remove the 

asterisk and enter the Accountant code or User ID. 
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Processing Status of Client 

You can filter your Client List based on the Processing Status currently assigned to your client’s file. The 
Processing Status indicates to you at which point you have reached in the completion of your client’s tax return. 

For example, it will indicate if you have errors in the data entry, if your client’s file is eligible for EFile, etc… 

In order to activate the processing status filters, click on Change processing status filters. 

A new window appears, allowing you to select several processing statuses for filtering. You can select up to 5 

processing statuses at the same time. 

The processing statuses you have chosen will appear in the Processing Status of Client section. 

Tip: Your best option when filtering through processing statuses is to only choose one processing status at a time. 

This will render more precise results when filtering. 
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Days since last activity 

You can filter your Client List based on the days since you have edited your clients’ files. Simply enter a range of 

number of days, for example from 0 to 30 days, to see which clients you have worked on during the last month. 

Year end 

You can filter your Client List using the clients’ year end date. Enter the date in the following format: ddmmyyyy. 

Enter the range of client year end you want to filter. 

Keywords 

You can filter your Client List based on the keywords you have entered in the Data Entry. For example, you can 

enter CCA-Class, and DT Max will find the clients that have capital cost allowance keyword in their Data Entry. You 

can search up to 4 keywords in one filter 

Tip: Your best option when filtering through keywords is to only enter one keyword at a time. This will render more 

precise results when filtering. 

You can also perform reverse filters with the Keywords section. Simply add an exclamation mark “!” at the front of 
the keyword you enter within this section, and DT Max will exclude the clients that have this keyword in their Data 

Entry. 
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Calculated Tax Data 

You can filter your Client List based on amounts calculated in the client’s tax return. For example, you can find 

clients that have an amount on a specific line of the tax return. 

In order to do so, you must first get the Field Codes on the tax return. To view the Field Codes, go to the View 

menu and select View or print blank forms. 

A new window will appear, allowing you to pick any form that DT Max produces and view it on the screen in blank 

format. 

Select the form on which you want to filter a specific field, and click Display. 
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Find the field or line you wish to apply a filter to, then go back to the View menu and select Show fields on tax 

return. 

You will notice that field codes will appear within every line of the form you are viewing. You can now either mark 

down the particular field code you need for use within a filter or you can print the form with the field codes showing 

and archive these pages for future reference when filtering. 

Once you have the field code you need, go back to the Client List, then go to the Tools menu, and select Filter 

the Client List. 
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Choose one of the spare filters to customize and click Edit filter. 

Go to the Calculated Tax Data section, and enter the field code you are searching for in the proper format. The 

field code you will enter is the same as the one you noted when you viewed the fields on the blank forms. 
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The field codes have to be entered in a specific format. You must also specify what precisely you are looking for 

within a particular field. For example, for a specific field, you have to specify whether the condition you want is that 

the field is equal to zero, or a field is within a specific range. 

When entering the field code, you must start with the percentage symbol “%”. For example, if the field you marked 

down and you want to filter on was D25:101, it must be entered as such: 

%D25:101 

Having specified the field code, you must now specify the condition, i.e., what are you looking for within this field. 

To specify the condition, you must use mathematical symbols such as: 

> Greater than 

< Smaller than 

= Equal to 

>= Greater than or equal to 

<= Smaller than or equal to 

Using the previous field as an example, if you are looking for a client that has an amount within this particular field, 

your filter would be entered as follows: 

%D25:101>0 

You can specify any amount within the condition. You can also use any of the mathematical symbols mentioned 

above. 

You can also search two field codes at the same time. In order to filter you client list based on one field code or 

another, you filter would be entered as follows: 

(%D25:101>0) %OR (%D25:101<0) 

You must enter each field code within brackets. 

If you are searching for one field code and another, your filter would be entered as follows: 

(%D25:101>0) %AND (%D25:101<0) 

Filters menu 

Once you have setup your filters, they will be placed in the Filters menu for future use. In order to re-select one, in 

the Client List, simply click on the drop-down menu and select the one you need. 
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Extracting and merging clients 

Extracting and merging clients is the process of exporting or importing existing client files in your Client List. 

Extracting Clients 

As a first step, you must select which clients you want to extract. To choose a client to extract, simply click on their 

name in the Client List. If you want to select several clients, press the Space bar on the names of the clients you 

wish to extract. A yellow highlight will cover their names in the Client List. 

Once you have selected the clients to extract, go to the Tools menu and select Extract. 

A new window will appear, allowing you to choose from several options. 

In the Clients to extract section, choose which clients you want to extract from the Client List. 
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In the Data to extract section, select which years you want to extract. 

In the bottom portion of the window, you can name and choose the path for which you want to save your extract. 

Click on the Browse button, and choose the path you want to save the extract through Windows Explorer. 
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Merging Clients 

In order to merge a client in your Client List, go to the Tools menu and select Merge. 

Windows Explorer will appear, allowing you to locate the client you wish to merge. Select the file and click Open. 

A new window will appear. In the Action section, select whether you want to “use the save levels” of the files or 

force the merge. 

Note: If the Client Number of the file you are trying to merge is 

already used in the Client List, DT Max will not allow you to merge the 

file. You will have to renumber the client file that is currently in your 

Client List. See the pertinent section below for instructions on how to 

renumber a client file. 
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Printing/Exporting the Client List 

DT Max allows you to print your Client List with the basic information of each of your client’s files. 

DT Max also allows you to export your Client List to other programs such as Excel, Word, or Outlook. 

In order to print or export your Client List, go to the File menu, select Print, then select Client List. 

You can also click on the printer icon located at the top task bar of the Client List. 

In the Select Clients section, choose which clients you want to print or export. 
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In the Destination section, select whether you want to print or export your Client List. 

If you choose to print, DT Max will print the Client List with the information you have chosen to display when you 

personalized your Client List (see the section Personalizing the Client List above). 

If you choose to Export to file, you can now select which information you want to export to Excel, Word, or 

Outlook. To choose the information you want to export, click on Select Data to Export. 

Tip: Your best option when exporting the Client List is to choose Export to file – comma delimited. 
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A new window appears, allowing you to choose what information you want to export. Tick the appropriate boxes 

and click OK. 

In the Name of file receiving the exported data, click on Browse. Windows Explorer will appear, allowing you to 

choose the path of the export file and to name the file. 

The format DT Max use for the export file is “.CSV”, which is compatible with most Microsoft Office applications 

such as Word, Excel, and Outlook.  

You can load this file directly using Microsoft Excel. The export file will have all the information you have selected 

to export. 

You can also use the export file as an address book for Microsoft Outlook. As a first step, make sure to choose the 

appropriate information for an address book such as e-mail, address, and phone number when selecting the data 

to export (see above). Once this is done, create the export file and then import the export file directly into Microsoft 

Outlook. 
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Backup/Restore your Client List 

DT Max offers a quick and efficient way to backup and restore your client files from the Client List. Not only does 

DT Max backup your client files, but it will also backup your Preferences menu settings. 

Tip: It is strongly recommended that you backup your client files at regular intervals. During tax season, we 

recommend that you backup the Client List at the end of every day. 

Backup 

To backup your client files from the Client List, go to the Tools menu, select Backup, then Backup. 

In the window that appears, choose the years and setup files you wish to backup. You can use CTRL + click to 

select which years and setup files you wish to backup. 

Click Next once you have made the appropriate selections. 

Tip: It is strongly recommended that you backup all years and settings. 
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DT Max will now prompt you to save your backup file in a particular location. Click Browse. 

Window Explorer will appear, allowing you to choose the location you want to save the backup file. 

You can rename the backup file to the name you wish. We recommend that you put the date you are backing up in 

the name of the file. 

Note: DO NOT change the name of the extension given to the backup file. 
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Restore 

To restore a backup file, go to the Tools menu, select Restore, then Restore. 

Tip: Make sure no other user is currently in the program when performing this task in a network database. 

DT Max will restart and a new window will appear prompting you to choose the backup file you have already saved. 

Click on Browse, and locate the specific backup file you wish to restore using Windows Explorer. 

Disclaimer: When restoring a Client List, DT Max will override and replace the existing Client List, including all 

your Preferences. Make sure that the backup file is up to date. 
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Renumbering Clients 

DT Max automatically assigns numbers to every client file you create in the Client List. This number is usually 

shown to the left of the client’s name. The Client Number is important in order to avoid duplicate files within your 

Client List (see Extracting and Merging Clients section above). 

To change the Client Number of an existing client in your Client List, you must select the client for which you wish 

to change the Client Number. They should appear highlighted in blue in your Client List. If you wish to change the 

client numbers of several clients, press the Space bar on the names of the clients you wish to renumber. A yellow 

highlight will cover their names in the Client List. 

Once you have selected your clients, go to the Tools menu, select Advanced Utilities, then select Renumber 

Client. 

A new window appears, allowing you to renumber your clients. 

In the Batch Selection section, choose the clients for which you wish to change the Client Number. 



56 

In the New number for this client section, enter the client number you want for your client. If you have chosen any 

other option except Current Client in the Batch Selection section, DT Max will ask for a range of Client Numbers. 

Click OK. 

DATA ENTRY 

Plans (Tax Planning) 

The Plans within DT Max represent a unique tool of the Data Entry that allows you to try out different tax scenarios 

without altering the client’s original file. DT Max will create up to six full tax returns within your client’s file that are 

distinct from your client’s original file. No need to create dummy files. 

You can try several different tax planning scenarios. Once you have created the scenario, DT Max will produce a 

comparative summary between these plans. 

Creating a Plan 

To create a Plan within the client’s Data Entry, click on the Production drop-down menu. 

DT Max now offers you six plans, indicated with the letters A to F. Choose the first plan offered, Plan A (blank). 
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A new window appears, allowing you to choose from several options: 

Keep Blank: Choose this option if you want to produce a new return. This is the option to choose when you are 

producing alternative tax returns. 

Copy from previous year’s production: Choose this option if you are trying a tax planning scenario for which the 

income levels are almost identical from one year to the next. In this case, DT Max will bring over the Data Entry you 

made for this client from the prior year into the Plan. 

Copy from Production: Choose this option if you want to try a tax planning scenario for the current year. In this 

case, DT Max will bring over the Data Entry you have already entered from the client’s current year original file 
(Production) into the Plan. 

Copy from next year’s production: Choose this option if you are in a prior year and want to bring over the Data 

Entry of the following year for comparative purposes. In this case, DT Max will bring over the Data Entry you made 

for this client from the following year into the Plan of the prior year. 

The most common scenario for which you will use plans is the current year tax scenario (Copy from Production 

option). The rest of the Plans chapter will show you how to use the Plans with this scenario. 

Once you have chosen Copy from Production, click OK. 
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Now you are in the Data Entry, which looks identical to your Production. However, the Production drop-down 

menu is now called Plan A. You can start making changes to your client’s tax return with the Plan. 

Naming your Plan 

The next step after creating your Plan is to name it. 

In order to name a Plan, add the keyword PLANTITLE. Enter the name of the Plan in the appropriate box. 
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Once you calculate the Plan, DT Max will rename the plan as per your entry within the keyword PLANTITLE. 

Editing the Plan 

You can edit the Data Entry of a Plan in the same way as you edit the production or original file. All the Data Entry 

features are available in a Plan. 

Delete Plans 

Plans created in the data entry screen can be remove from the DT Max menu. Simply click on File then Delete 

plans. 

Planning Summary 

Once you have completed editing the Data Entry of the Plan and calculate the Plan, DT Max will produce a 

Planning Summary in the Page Index of the Tax Return Screen. 
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The Planning Summary gives you a line-by-line comparative between all the plans you create. At the top of the 

Planning Summary, you will see the result of each plan side by side. 

The Planning Summary will only show the comparative between the Plans; the Production return is not included. 

Tip: When creating Plans for current year tax planning purposes, you should not make any changes to your Plan 

A. Simply copy the Production to Plan A, name it, and go on to Plan B to make your changes. 

Printing Plans 

You can use Production printing when printing a Plan. 

To print the entire tax return in a Plan, while in the Tax Return Screen, click on the Production Printing icon. 

In the Print Job Setup window, under the Which versions section, select Other versions. Now select the 

appropriate Plan. Click Print. 

Disclaimer: Although you can print a 

Plan using Production Printing, no bar 

code will print from a Plan. Moreover, 

you cannot EFile a Plan. 
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Right-hand side display 

The Right-hand side display is a unique feature to DT Max which allows you to have real-time comparatives while 

you are completing your client’s Data Entry. For example, you can view the entries you made in the previous year 

on the right-hand side of the Data Entry. 

Not only can you view comparative information, you can also bring over information from the right-hand side to your 

client’s Data Entry (see pertinent section below). 

Previous year 

The first option you can choose from the Right-hand side display is the previous year. Click on the drop-down 

menu, and select the previous year. 

Now all the client’s prior year Data Entry is displayed in the right-hand side of the screen. 

All prior year amounts will match up side by side with the current year amounts as long as the description entered 

for the slip or business statement is the same from one year to the next. 
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Carryforwards from the previous year 

You can display the carryforward amounts from the previous year on the right-hand side. Simply select 

Carryforwards from XXXX on the right-hand side display drop-down menu. 

Tip: This option is particularly useful if you accidentally lose the carryforwards within your client’s Data Entry. You 

can always recover them using this option. 

Other Client 

You can also choose to display any other client located in the Client List on the right-hand side. The only 

information you need is the Client Number of the client you wish to display on the right. 

Go to the right-hand side drop-down menu, and select Other Client. 

A new window appears. Enter the client number of the client you wish to display on the right. Then choose which 

version of the file you want to see and which year. Click OK. 
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Now you can see side-by-side the Data Entry of your client with the “other client” displayed on the right. 

Tip: This option can be particularly handy when you have 2 business partners. Once you have completed the 

business statement of the first partner, you can choose this partner as the “other client” on the right-hand side of 

the second partner, and copy over the statement (see pertinent section below). 

Plans 

You can display the Data Entry you performed in a specific Plan on the right-hand side. Click on the right-hand side 

drop-down menu and select the specific Plan you wish to display. 

Copy data from right to left 

For any option you choose on the Right-hand side display feature, you can copy selected data from the right-hand 

side to the left. 

To copy data for entire keyword groups, click on the Main keyword of the group for which you want to copy data 

that is located to the left. 

Then, press F5 to highlight the group. 
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Once the keyword group has been highlighted, right-click in the highlighted area and select Copy to left-hand 

side. 

You can also use the shortcut keys ALT+C. 

You can also copy individual keywords from the right-hand side to the left. 

To highlight a specific keyword for which you want to copy the data from the right-hand side, simply CTRL + Click 

on the keyword itself. Then copy over the data from right to left using the process mentioned above. 

Review Tags 

The Review Tags feature allows you to tag a specific keyword entry when you are working in the Data Entry 

screen. To place a review tag simply right-click the relevant keyword entry. A new window will appear. Select Tag 

Keyword “For review”. 
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An exclamation and interrogation mark symbol will appear beside the entry. 

Once a Review Tag is inputted, DT Max will add a review note in the Error and warning messages section. To 

view these review notes, click on the Error and warning messages icon. 

In this new window, you will be able to view the list of error and warning messages as well as the review tags. 

To jump to the review tag in the Data Entry, select the message and click Go to keyword. 

The keyword will be highlighted in your client`s Data Entry. 
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“Checked OK” Keyword Tag 

The “Checked OK” keyword tag allows you to remove a “For review” tag or dismiss a warning message indicated 

in the Error and warning messages section. To input the “Checked OK” keyword tag, in your client’s data entry, 
right-click the relevant keyword entry. A new window appears. Select Tag Keyword “Checked OK”. 

A checkmark symbol will now appear beside the entry. 

The entry was tagged “For review”: By tagging the entry “Checked OK”, DT Max removes the corresponding 
warning message that appeared in the Error and warning messages section as well as marking the entry with a 

checkmark. 

The entry is “inconsistent”: In the Error and warning messages section, DT Max generates a warning when an 

amount seems inconsistent in respect to other relevant entries. DT Max will then suggest the expected amount for 

that entry. By tagging the entry “Checked OK”, you can confirm the original amount entered and effectively dismiss 

the warning message. This warning message will no longer appear in the Error and warning messages section. 
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Keywords 

Address 

Enter the head office address of the company using the drop down of the keyword Address. 

Specify the mailing address and location of books and records in the keywords MailAddress and BooksAddress. 

Note: If the mailing address differs from the head office address, add a second keyword Address in the data entry 
to complete the mailing address. 
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If the mailing address is the address of the accountant, in the drop down menu of the second keyword Address, 
choose Mailing Address and complete the keyword with the accountant’s information. 

The same option applies if the address of the books and records differ from the head office. 

Jurisdiction 

The Jurisdiction keyword must be used at least twice in the data entry. The first keyword should be the federal 
jurisdiction and the second for the province of establishment of the company. 
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Corporate officers 

Enter information regarding the directors of the company using the dropdown menu of the keyword CorpOfficers. 

Note: If the director of the company is also the signing officer, in the drop down menu use the option Director and 
signing officer. 

The General Index of Financial Information (GIFI) 

In the Keyword GIFI you will be able to import or manually enter you financial statement. 

For the manual entry, use the drop down menu from the main keyword grouping and select the option DT Max - 
manual entry. 
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The Synchronize keyword gives you the option to update or to not update the net income and the tax on capital 

keywords in DT Max. 

Use the keyword IFRS-Prep to indicate whether or not the corporation used the International Financial Reporting 
Standards (IFRS) when it prepared its financial statements. 

If this keyword is not used, DT Max will default to "No". 

In the keyword GIFI-Form use the drop down menu to select the financial statement you wish to complete. 

Double click on the keyword GIFI-Field to manually enter the amounts of your financial statement. 
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In the new window, GIFI Editor, choose the appropriate items to report the amounts of your financial statements. 

Use the search bar to research a specific item in the GIFI editor. 

Click OK to save the amounts entered in the GIFI editor. The amounts will be reported in the data entry in the 
keyword GIFI. 
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To import your financial statement in DT Max, use the drop down menu of the main keyword grouping GIFI. 

In the new window, Import GIFI, select the GIFI file you wish to import in DT Max. Click on Browse to locate the 
GIFI file on your computer. 

Choose the sections of the GIFI file you wish to import in DT Max and specify whether you want to update the 
keywords and NETINCOME and TAXONCAPITAL GIFI. 

Click on Ok to save your selection. 
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In the Confirm GIFI import window, click OK to import the file. 

Your financial statement will be automatically imported in the data entry screen of DT Max. 

To view the totals in the GIFI keyword, go to the Preferences menu and select User interface. 
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In the User interface window, add a check to the sentence “Show automatically calculated GIFI totals in the 
editor”. 

Capital cost allowance 

Use the keyword CCA-Class to enter the amount of depreciation and amortization claimed on the NETINCOME 
keyword on the sub-keyword Depreciation. 

Use the dropdown menu to select the CCA Class. 

mk:@MSITStore:C:/dtprog/maxv999/kb/2013/dtwkbE.chm::/Keywords/T2/g556.htm#NETINCOME
mk:@MSITStore:C:/dtprog/maxv999/kb/2013/dtwkbE.chm::/Keywords/T2/g556.htm#DEPRECIATION


75 

Secondary keywords: 

Enter the opening undepreciated capital cost or cumulative eligible capital in the UCCOpen keyword. 

For keyword Disposal, enter a description of the assets disposed during the year and then p the "Enter" key of 
your keyboard to open the sub-keywords of the section. 

Specify whether you have liquidated the class with the keyword Liquidate and enter the net proceeds. 

Moreover, all purchases made within the class should be reported in the keyword Additions. 
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Use CCALimit to limit the capital cost allowance or cumulative eligible cost amount to be claimed on this class. If 
there is no amount is reported, DT Max claims the maximum amount. 

Two fiscal years ending in the same calendar year 

To complete two fiscal years ending in the same calendar year, begin by completing the first fiscal year. 

To complete the second fiscal year, add a new customer by clicking on the icon Add a new client or by pressing 
the F3 on your keyboard. 

Click Ok to create the new corporation 



77 

In the data entry of the new file use the drop down menu of the right hand side display and select the option Other 
Client. 

In the Client to display on right-hand side window, enter the client number of the first fiscal year. 

In the section Tax plan version select Production and choose the Next Year in the Year section. 

Click on OK to save the changes. 
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In the data entry screen, you will see the data of the first year end displayed on the right hand side. 

Do F5 and use your mouse to select the keywords on the right hand side, so that they are highlighted in yellow. 

Do ALT+C to copy the data of the right hand side to the left or use the right click of your mouse and select the 
option copy to left-hand side. 

Complete the tax file of the second fiscal year. 
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Income source 

Use the keyword IncomeSource to include the deductions not eligible for the small business deduction. 

Specify the source of income by clicking on the dropdown menu of the keyword IncomeSource. 

Dividend Paid 

Enter all dividends paid this year in the DividendPaid keyword. DT Max will use the amount of taxable dividends 
paid to calculate the current year dividend refund. Amounts entered will also be reported on schedule 3 (T2S (3)). 
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TAX RETURN 

Review Tags 

DT Max’s review tags feature allows you to directly tag a field on the tax return for further review. To access this 

feature, simply right-click the field you wish to tag. You will have a selection of four different tags to choose from. 

Similarly to the tagging tool available in the Data Entry screen, DT Max allows you to tag a field either “For review” 

or “Checked OK”. The utilities of these tags were explained in the previous section. 

In the Tax Return screen, two additional review tags are available for use. 

When tagging a field as “Error”, DT Max will highlight the field in red and input an X symbol in the navigator section 

to the left of the screen to indicate that an error is present and must be verified before the final production of the tax 

return. 



81 

Once the error tag has been verified, you may right-click the field and select Tag: Final check. 

DT Max will now highlight the field in green and input a double checkmark symbol in the navigator. 

In addition to the review tags, DT Max also allows you to attach notes to specific fields on the tax return. To add a 

note, right-click the desired field and select Add a review note. 
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A new window will appear allowing you to enter a review note of up to maximum of 400 characters. Once you have 

entered the note, click Save. 

A yellow note page symbol will appear in the navigator indicating that a review note is present. 

Once one or more review notes are no longer required, you may choose to remove them individually or all at once. 

To remove an individual review note, right-click the corresponding field and select Edit the review note. 
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From the Field Review Note window, select Remove this note. 

To delete all the review notes and tags at once, right-click any field and select Remove ALL review tags from this 

client. 

PDF 

DT Max’s PDF function allows you to save selected pages of the tax return as PDF files. These files can be 
archived or even sent in an e-mail directly through DT Max. 

To access this feature, once on the Tax Return screen, click the PDF icon located on the toolbar. 
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A new window will appear. 

To save selected pages of the tax return as PDF files, tick the box next to Save as a PDF file. 

Once selected, you will be able to browse a save location by clicking the browse icon. 

Three additional options are also available. You may chose to Open the file in Acrobat® when created, to 

Protect the file with a password, and to Include field review tags in the saved PDF file. 
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In order to send the PDF files directly as an e-mail, simply tick the box next to Email directly and enter the relevant 

information in the section below. 

The Select pages section allows you to make a selection of which pages you would like to save to PDF or send 

directly by e-mail. DT Max will only list the relevant pages with regards to your client. 

Tip: You may choose to select the pages one at a time by holding down CRTL on your keyboard and clicking the 

corresponding pages from the list. 
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PREFERENCES MENU 

Security System 

DT Max features a security system which enables you to set up the program so that only authorized personnel are 

allowed to use certain specified attributes. 

When DT Max is first installed, all users can access any program feature as passwords are not required until the 

security system is activated. 

User IDs and passwords are tied to a specific DT Max database. If you use different databases, each database 

must have its own security system setup. 

Setting up a supervisor 

As a first step, you must set yourself up as a DT Max supervisor. In order to do this, you must create your 

password. 

Go to the Preferences menu, select Security System, and then select Your personal passwords and rights. 

A new window appears. Enter your new password at the top right. Make sure that in the Personal Rights section, 

the box next to System Supervisor is ticked. Click SAVE. 
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Company Database Security Policy setup 

Once you have set up the supervisor, you must now set up the Company Database Security Policy. 

Go to the Preferences menu, select Security System, and then select Company database security policy. 

In Your personal password, enter the password you set up in the previous step. 
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In Database encryption password, enter the password you had set up for the database during the installation 

process. Click OK 

Now the Password requirements section unlocks, allowing you to choose amongst the two options presented. 

Select Password required and then click Apply changes. 
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Restart DT Max. You will now be required to enter your password in the Splash Screen. 

Enter your password in the appropriate box and click Start. 

Individual users’ passwords and rights 

Once you have setup the Company database security policy, you must now assign a username, password, and 

rights to all other users of DT Max. 

Go to the Preferences menu, select Security System, and then select Individual users’ passwords and rights. 
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A new window appears. Click New to add a user to the database. 

In the Required user information section, enter the user name and password of the new user you are creating. 
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In the User’s security access and rights section, untick System Supervisor and then untick the rights you want 

to disable for this particular user. 

Click OK once you are done. 

Archiving and PDF 

The archiving and PDF tool allows you to greatly reduce the volume of paper used to store your client’s documents. 

Once enabled, DT Max will automatically save an archived copy of the tax returns produced. These archived files 

are stored in a PDF format easily accessible for future viewing or printing. 

To access this feature, go to the Preferences menu and select Archiving and PDF setup. 
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A new window will appear with several options. 

In the When to archive automatically section, you may choose amongst 4 options. Make the appropriate 

selection. 

Tip: We strongly recommend to select the “Archive when all destinations are printed´option. 

In the Location of saved archive files section, you may select the location of the base folder where the files will 

be archived. DT Max will implicitly offer you to save the files in a subfolder located in your database folder. 



93 

You may however choose to manually select a base folder location by ticking the box next to “Specify the name 

and location of the base folder” and clicking on the “browse” icon. 

Tip: We strongly recommend to keep the “Use different subfolders for T1, T2, T3” and “Use a different 

subfolder for each tax year” options selected. This will ensure a proper classification and archiving of your client 

files. 

In the Naming convention for archive files section, choose amongst the 4 options. This section will determine 

how the files will be named in the archive folder. The file name can be composed of the client’s name, client 

number, and business number. 

Tip: We recommend using the “Client name, client number, business number” option. 
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